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Abstract

These Application Notes describe the steps necessary for configuring Session Initiation
Protocol (SIP) Trunk Service for an enterprise solution consisting of Avaya IP Office Release
11.0 to interoperate with Claro SIP Trunking Service.

The test was performed to verify SIP trunk features including basic calls, call forward (all
calls, busy, no answer), call transfer (blind and consult), conference, and voice mail. The calls
were placed to and from the PSTN with various Avaya endpoints.

Claro SIP Trunking Service provides PSTN access via a SIP trunk between the enterprise and
Claro’s network as an alternative to legacy analog or digital trunks. This approach generally
results in lower cost for the enterprise.

Readers should pay attention to Section 2, in particular the scope of testing as outlined in
Section 2.1 as well as the observations noted in Section 2.2, to ensure that their own use cases
are adequately covered by this scope and results.

Information in these Application Notes has been obtained through DevConnect compliance
testing and additional technical discussions. Testing was conducted via the DevConnect
Program at the Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the steps necessary for configuring Session Initiation Protocol
(SIP) Trunk Service for an enterprise solution consisting of Avaya IP Office Release 11.0 to
interoperate with Claro SIP Trunking Service.

In the sample configuration, the Avaya SIP-enabled enterprise solution consists of Avaya IP
Office 500v2 Release 11.0 (hereafter referred to as IP Office), Avaya Communicator for
Windows, Avaya Communicator for Web, Avaya Equinox for Windows and Avaya Deskphones,
including SIP and H.323.

During the interoperability testing, feature test cases were executed to ensure interoperability
between Claro and IP Office.

During the interoperability testing, a VPN connection was used to connect the simulated Avaya
enterprise network to Claro’s network via the public Internet. The connection could also be done
without the use of VPN.

The Claro SIP Trunking Service referenced within these Application Notes is designed for
business customers. Customers using this service with the IP Office solution are able to place
and receive PSTN calls via a broadband WAN connection using the SIP protocol. This
converged network solution is an alternative to traditional PSTN trunks such as analog and/or
ISDN-PRI trunks. This approach generally results in lower cost for the enterprise.

The terms “Service Provider” and “Claro” will be used interchangeable throughout these
Application Notes.

2. General Test Approach and Test Results

The general test approach was to simulate an enterprise site in the Avaya Solution &
Interoperability Test Lab by connecting IP Office to Claro SIP Trunking Service, a VPN
connection was used to connect the simulated Avaya enterprise network to Claro’s network via
the public Internet, as depicted in Figure 1.

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent
to the interoperability of the tested products and their functionalities. DevConnect Compliance
Testing is not intended to substitute full product performance or feature testing performed by
DevConnect members, nor is it to be construed as an endorsement by Avaya of the suitability or
completeness of a DevConnect member’s solution.

Avaya recommends our customers implement Avaya solutions using appropriate security and
encryption capabilities enabled by our products. The testing referenced in this DevConnect
Application Note included the enablement of supported encryption capabilities in the Avaya
products only (private network side). Readers should consult the appropriate Avaya product
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documentation for further information regarding security and encryption capabilities supported
by those Avaya products.

Support for these security and encryption capabilities in any non-Avaya solution component is
the responsibility of each individual vendor. Readers should consult the appropriate vendor-
supplied product documentation for more information regarding those products.

2.1. Interoperability Compliance Testing
To verify SIP trunk interoperability, the following areas were tested for compliance:

SIP OPTIONS queries and responses.

Incoming calls from the PSTN were routed to the DID numbers assigned by Claro.
Incoming PSTN calls were terminated to the following endpoints: Avaya 96x1 Series IP
Deskphones (H.323), Avaya 1100 Series IP Deskphones (SIP), and Avaya
Communicator for Windows, Avaya Communicator for Web and Avaya Equinox for
Windows.

Outgoing calls to the PSTN were routed via Claro’s network to various PSTN
destinations.

Caller ID presentation.

Proper disconnect when the caller abandons the call before the call is answered.

Proper disconnect via normal call termination by the caller or the called parties.

Proper disconnect by the network for calls that are not answered (with voicemail off).
Proper response to busy endpoints.

Proper response/error treatment when dialing invalid PSTN numbers.

Proper Codec negotiation and two way speech-path. (Testing was performed with codecs:
G.711MU, G.711A and G.729A, Claro’s preferred codec order).

No matching codecs.

Proper early media transmissions.

Voicemail and DTMF tone support (leaving and retrieving voice mail messages from
PSTN phones).

e Outbound Toll-Free calls, interacting with IVR (Interactive Voice Response systems).
e Calling number blocking (Privacy).
e Call Hold/Resume (long and short duration).
e Call Forward (unconditional, busy, no answer).
e Blind Call Transfers.
e Consultative Call Transfers.
e Station Conference.
e Mobility twinning of incoming calls to mobile phones.
e Simultaneous active calls.
e Long duration calls (over one hour).
e Proper response/error treatment to all trunks busy.
e Proper response/error treatment when disabling SIP connection.
e T.38 fax.
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Note: Remote worker was not tested with this solution since the Avaya Session Border
Controller for Enterprise (Avaya SBCE) was not included in the configuration used during the
compliance testing. The Avaya SBCE is a required component for enterprises planning to deploy
Remote Workers.

Items not supported or not tested included the following:

The SIP REFER method for call redirection was not tested for reasons noted under
Section 2.2.

G.711 fax pass-through was not tested.

Inbound toll-free calls, Outbound Toll-Free calls, 911 calls (emergency), “0” calls
(Operator), 0+10 digits calls (Operator Assisted), and 411 calls (Local Directory
Assistance) were not tested.

2.2. Test Results

Interoperability testing of Claro SIP Trunking Service was completed successfully with the
following observations/limitations.

SIP REFER: Calls from the PSTN to IP Office that are re-directed to another PSTN
endpoint by the IP Office user, with REFER enabled in IP Office, did not work properly.
Testing was done with REFER disabled in IP Office, refer to Section 5.4.1.

Fax support: T.38 Fax transport did not work properly, T.38 fax is under investigation
by Claro.

Caller ID on calls forwarded to the PSTN and to “twinned” mobile phones — On
calls originated from the PSTN to IP Office stations with either call-forward or with the
mobility feature active in the IP Office station to another PSTN number, the caller ID
number displayed at the terminating PSTN station was always of the DID number
assigned to the IP Office station, instead of the originating PSTN number. This issue is
caused by IP Office sending INVITE messages to Claro for calls being forwarded and for
twinned calls to mobile stations with the DID number assigned to the IP Office station in
the “From” header instead of sending the PSTN number that originated the call. This
issue is under investigation by Avaya.

Outbound Calling Party Number block (calls with privacy enabled) — The Calling
Party Number is not blocked on calls from IP Office to the PSTN with privacy enabled at
the IP Office station (Withhold Number enabled). This issue is caused by IP Office not
including the privacy header (privacy = id) in the INVITE message sent to Claro. This
issue is under investigation by Avaya.

Conference on Avaya Equinox soft-client — Conference on the Avaya Equinox for
Windows soft-client is not working properly. When the attempt is made to conference
active calls in the Avaya Equinox for Windows soft-client by “merging” the calls
together, the parties are not joined together into conference, instead a new call is made
from the first active call that was held by the Equinox soft-client to the second active call
held by the Equinox soft-client, with the Avaya Equinox soft-client unable to merge the
active calls together into conference. This issue was only seen on the Avaya Equinox for
Windows soft-client. There is no current work-around; if the conference feature is needed
on an Avaya soft-client for IP office the Avaya Communicator for windows soft-client
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could be use until this issue is resolved by Avaya. This issue is under investigation by
Avaya.

e Outbound call from an enterprise extension to a busy PSTN number — Claro did not
send a “486 Busy Here” message on an outbound call to a PSTN station that was busy, as
expected. There was no direct impact to the user, who heard busy tone.

e No matching codec on outbound calls: If an unsupported audio codec is received by
Claro on the SIP Trunk (e.g., 722-64K), Claro will respond with “500 Server Internal
Error” instead of “488 Not Acceptable Here”, the user will hear re-order. This issue does
not have any user impact, it is listed here simply as an observation.

2.3. Support

For support on Claro systems visit the corporate Web page at:
http://www.claro.com.do/wps/portal/do/sc/empresas

Avaya customers may obtain documentation and support for Avaya products by visiting
http://support.avaya.com. Alternatively, in the United States, (866) GO-AVAYA (866-462-8292)
provides access to overall sales and service support menus.

3. Reference Configuration

Figure 1 illustrates the test configuration used for the DevConnect compliance testing. The test
configuration simulates an enterprise site with an Avaya SIP-enabled enterprise solution
connected to the Claro SIP Trunking Service through the public Internet.

The Avaya components used to create the simulated enterprise customer site includes:
e Auvaya IP Office 500v2.
e Auvaya IP Office Application Server running Avaya Voicemail Pro, Avaya one-X® Portal
for IP Office and Avaya WebRTC Gateway.
Avaya 96x1 Series H.323 IP Deskphones.
Avaya 1100 Series SIP IP Deskphones.
Avaya Communicator for Windows softphone.
Avaya Equinox for Windows softphone.
Avaya Communicator for Web softphone.

The enterprise site contains the Avaya IP Office 500v2 with analog and digital extension
expansion modules, as well as a VCM®64 (Voice Compression Module) for supporting VolP
codecs. The LANL1 port of IP Office is connected to the enterprise LAN (private IP network);
LANL1 port is also used to connect to Claro’s network via a VPN connection. Endpoints include
Avaya 96x1 Series IP Deskphones (with H.323 firmware), Avaya 1100 Series IP Deskphones
(with SIP firmware), Avaya Communicator for Windows softphone, Avaya Equinox for
Windows softphone and Avaya Communicator for Web softphone. The site also included an
Avaya IP Office Application Server running Avaya Voicemail Pro (providing voice messaging
service to the IP Office users), Avaya one-X® Portal for IP Office and Avaya WebRTC
Gateway.
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For the purposes of the compliance test, users dialed a short code of 9 + N digits to make calls
across the SIP trunk to the PSTN via Claro’s network. The short code 9 was stripped off by IP
Office but the remaining “N” digits were sent unaltered to the network. Refer to Section 5.6.

In an actual customer configuration, the enterprise site may include additional network
components between the service provider and the IP Office system, such as firewalls. A
complete discussion of the configuration of these devices is beyond the scope of these
Application Notes. However, it should be noted that all SIP and RTP traffic between the service
provider and the IP Office system must be allowed to pass through these devices.
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For confidentiality and privacy purposes, public IP addresses and DID numbers used during the
compliance testing have been masked.

Service Provider

Gateway: 192.168.250.188

| UDP/RTP

( ! Simulated Enterprise
| Domain: avaya.lab.com
| DIDs: 123-456-9226, 9854
[ [N (PSec Tunnel
Virtual Router | ——————
| i =S /PN Firewall
Ethd: 10.64.70.53 Eth3: 10.64.120.8
LAN1: 10.64.70.60 10.64.101.246
Awvaya I[P Office 500 V2.
Rel 11.0
] T
Avaya |[PO Office
Application Sever;
- Avaya One-X Portal
- Avaya Voicemall Pro - Avaya |P Office !ﬂnnager
- Avaya WebRTC gateway -mﬂ:::::mmunlcaturfcr Avaya 96x1 Series Avaya 1100 Series IP
- Avaya Equinox for IP Deskphones Desklphones
Windows (H.323) {SIP)
- Avaya Communicator for
Fax Web
. _/
Figure 1: Avaya Interoperability Test Lab Configuration
HG; Reviewed: Solution & Interoperability Test Lab Application Notes 7 of 39

SPOC 9/26/2018 ©2018 Avaya Inc. All Rights Reserved. Claro_IPO11



4. Equipment and Software Validated

The following equipment and software were used for the sample configuration provided:

Equipment/Software

| Release/Version

Avaya

Avaya IP Office 500v2

11.0.0.1.0 Build 8

Avaya IP Office DIG DCPx16 V2

11.0.0.1.0 Build 8

Avaya IP Office Manager

11.0.0.1.0 Build 8

Avaya IP Office Application Server
= Voicemail Pro
= Avaya WebRTC Gateway
= Avaya one-X® Portal for IP Office

11.0.0.0 Build 849
11.0.0.0 build 481
11.0.0.0 build 849
11.0.0.0 build 457

Avaya 96x1 Series IP Deskphones (H.323)

Version 6.6604

Avaya 1140E IP Deskphones (SIP)

SIP1140e Ver. 04.04.23.00

Avaya Communicator for Windows 2.1.4.0

Avaya Equinox™ for Windows 3.4.4.45.14

Avaya Communicator for Web 1.0.16.2220
Claro

IMS Huawei CSCF-BCF VV100R010C00SPC100

SBC Huawei SBC2900 VV300R002C00SPC200

Note: Compliance Testing is applicable when the tested solution is deployed with a standalone
IP Office 500v2 and also when deployed with all configurations of IP Office Server Edition.
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5. Configure Avaya IP Office

IP Office is configured through the Avaya IP Office Manager application. From the PC running
Avaya IP Office Manager, select Start - Programs - IP Office > Manager to launch the
application. A screen that includes the following may be displayed.

WELCOME to IP Office Administration

What would you like to do?

Create an Offline Configuration

| Open Configuration from System|

Read a Configuration from File

Select Open Configuration from System. If the above screen does not appear, the configuration
may be alternatively opened by navigating to File > Open Configuration at the top of the
Avaya IP Office Manager window. Select the proper IP Office system from the pop-up window
and log in with the appropriate credentials.

The appearance of the Avaya IP Office Manager can be customized using the View menu. In the
screens presented in this document, the View menu was configured to show the Navigation pane
on the left side, omit the Group pane in the center, and show the Details pane on the right side.
Since the Group pane has been omitted, its content is shown as submenus in the Navigation
pane. These panes (Navigation, Group and Details) will be referenced throughout the IP Office
configuration. All licensing and feature configuration that is not directly related to the interface
with the service provider is assumed to already be in place.

In the sample configuration, IP500V2 Main was used as the system name. All navigation
described in the following sections (e.g., License = SIP Trunk Channels) appears as submenus
underneath the system name 1P500V2 Main in the Navigation Pane.
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5.1. Licensing and Physical Hardware

The configuration and features described in these Application Notes require IP Office to be
licensed appropriately. If a desired feature is not enabled or there is insufficient capacity, contact
an authorized Avaya sales representative.

To verify that there is a SIP trunk channels license with sufficient capacity; click License in the
Navigation pane. Confirm a valid license with sufficient Instances (SIP Trunk Channels) in the

Details pane.

IP Offices &f -

- K BOOTR (9)
¥]-45% Operatar (3)
=149 System (1)
.59 IPSOOVZ Main
H-F9 Line (25)
|-z Contral Unit {4)
H--.4fy Extension (45)
H-§  User (50)
- Group (1)
- @ Short Code (63)
----- B service (0)
B olfy RAS (1)
[]...Q Incoming Call Route (3)
----- B8 waN Port (0)
----- a4 Directory (D)
£ Time: Profile (0)
G- @) Firewall Profile (1)
= [fll IF Route (7}
----- & Account Code (0)
----- L ILiI:E!I'I:'-E! {9m)
----- & Tunnel {0)
[]---n 4 User Rights (8]
B g ARS (2)
----- B Location (0)
----- 2% Autharization Code (0)

License |Rem0te Server I
License Mode License Mormal

Licensed Yersion 11,0

—

PLDS File Status  alid

PLDS Haost 1D

Expiration Date:l Add... |

Feature | K | Instances I Skatus
WIPra TTS (Genetic) A 40 Valid ever
Teleworker A 84 Walid Tever
Tobile 'Worker A it ) Walid Tlever
Office Warker A 354 Yalid Mever
fvaya Softphone Licence A 100 Valid ever
WMPro TTS {Scansoft) A 40 Walid Tever
WMPro TTS Professional A 40 Walid Tlever
1PSec Tunneling A 1 Yalid Mever
Pawer ser T 354 Yalid Mever
Avaya [P endpoints A 354 Valid Mever
IPS00 Yoice Metworking Channels A i Walid Tever
|5TP Trurk Channels A 128 Walid Hever|
IPSO00 Universal PRI (Additional chan,..  N/'& 100 Valid Mever
CTI Link Pro A 1 Valid Mever
Wawe User A 16 Walid Tever
Zrd Party IP Endpoints A aiEd Walid Tlever

Remove |
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To view the physical hardware comprising IP Office, expand the components under the Control
Unit in the Navigation pane. In the sample configuration, the Avaya IP Office 500v2 is
equipped with analog and digital extension expansion modules, as well as a VCM64 (Voice
Compression Module) for supporting VolP codecs. An IP Office hardware configuration with a
VCM component is necessary to support SIP Trunking Services.

To view the details of the component, select the component in the Navigation pane. The
following screen shows the details of the Avaya IP 500 V2.

IP Offices | & IP 500 V2

=- R BOOTP (3 Uit |
g5 Operator (3)

=42 IPS00VE Main Device Mumber |1

Uit Type IIF‘ 500 W2

""‘"-i.-' S‘:,-'StEITI |:1:|
-1 Line (25)

Wersion |11.|:|.n.1.n build &

Serial Mumber I

“y 3 PHOMES

Ly 6 DIG DCPX16 W2
[+ Extension (43) Interconnect Mumber I':'

@ User (50}

(-4 Group (1) Maodule Murmber I':'Z'"'tr'z'l Linit
(-8 Short Code (69)

----- @8 Service ()

-l RAS (1)

Eﬂ---@ Incoming Call Route (3)
----- BB wan Port (0)

----- g Directory (00

----- £ Time Profile (0)

Eﬂ---@- Firewall Prafile (1)
-l IP Route (7)

----- i Account Code (00

----- e License (90)

----- % Tunnel (1)

Eﬂ"'# 3 Wser Rights (&)

R ARS (2)

----- G Location (00

----- @ Authorization Code (00

Unit IP Address |1D.54.?n.5n
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5.2. System

Configure the necessary system settings. In an IP Office system, in an actual customer
deployment, when a VPN connection is not used, the LANZ2 port is used to connect to the public
network, and the LANL1 port is used to connect to the private network. During the compliance
testing, since a VPN connection was used, the LAN1 port was used to connect to the private
network and to connect to Claro’s network, the LAN2 port was not used.

5.2.1. System — LAN1 Tab

In the sample configuration, the IP Office LAN1 port was used to connect to the enterprise
network (private network) and to Claro’s network. To access the LAN1 settings, first navigate to
System - <Name>, where <Name> is the system name assigned to IP Office. In the case of the
compliance test, the system name is IP500V2 Main. Next, navigate to the LAN1 - LAN
Settings tab in the Details pane. Set the IP Address field to a private IP address on the
enterprise LAN side (private IP network). Set the IP Mask field to the mask used on the
enterprise LAN side (private IP network). All other parameters should be set to default or
according to customer requirements. Click OK to commit (not shown).

IP Offices | B IPS00V2 Main
'"a BOOTP (9) .S',-'stem ‘LaNL {Lanz | DMS I Yaicemail | Telephu:un',-'l Direckary Servicesl Syskemn Events |
B-{# Operator (3} :
Bz [IPs00Yz Main LAN Settings I YalP I Metwork Topology I
E| =) Syskem (1)
{...smy IPSOOYE Main IP Address I 10 . 64 . 70 . A0
-1 Line (25] 1P Mask [255 285 . 2855 . O
[ Contral Unit (4)
-4 Extension (48] Primary Trans, IP Address I o .o .0 .0
a Lser (S0}
u Group (1) RIP Mode INu:une j
g Short C?:d; (69) I Enable MaT
il Service (0
,.,g; RAS (1) Mumber OF DHCP IP Addresses |2DE| E:
@ Incoming Call Route (30 DHCP Made
- BE WAN Part (0)
s Directory (0) " Server  client © Dialln ¥ Disabled advanced
----- {.H‘ Time Profile {0}
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On the VolIP tab in the Details pane, configure the following parameters:
e Check the H323 Gatekeeper Enable to allow Avaya IP Telephones/Softphone using the
H.323 protocol to register.
e Check the SIP Trunks Enable to enable the configuration of SIP Trunk connecting to

Claro.

e Check the SIP Registrar Enable to allow Avaya IP Telephones/Softphone to register
using the SIP protocol.

e Enter the Domain Name of the enterprise under SIP Domain Name.

e Enter the SIP Registrar FQDN of the enterprise under SIP Registrar FQDN.

e Verify the UDP Port and TCP Port numbers under Layer 4 Protocol are set to 5060.

e Verify the RTP Port Number Range settings for a specific range for the RTP traffic.
The Port Range (Minimum) and Port Range (Maximum) values were kept as default.

| IP Offices

BOOTR (9)
+ Operator (3)

=) IPS00YZ Main
H-F4 Line (25)
H-<22 Conkral Unit (4)
H-- 4 Extension (48)
]i User (50)
]u Group (1)
/- @ short Code (69)
----- @ Service (0)
-aify RAS (1)

..... £8) waN Part (0)

----- i Directory (00
€17 Time Profile (0)
(-8 Firewall Prafile (1)
G- Jill 1P Raute (7)

----- & Account Code (0)
----- W License (90)

----- % Tunnel {0)
[]...a.; User Rights ()
E- ARS (2)

----- G Location (0)

[]---@ Incoming Call Route {3)

----- 2% futharization Code (0)

| Syskerm

LAM Setking:

LAM1L

¥ H.323 Gatekeeper Enable I

ebwork Topaology |

IP500v2 Main

Lanz | ous | voicemal | Telephony | Directory Services | System Events | smTp | sMR | wem | volp | volP Security

[T Auto-creats Extension

™| Auto-creates User

¥ H.323 Remate Extension Enable

H.323 Signaling over TLS IPreFerred 'l Remote Call Signaling Port II?ZD 3:

v sip Feegistrar Enable

¥ SIP Trunks Enable

[ Auto-creats ExtensionUser

¥ SIP Remote Extension Enable

SIP Dornain Mare

SIP Registrar FQDN

Iavaya.lah.com

Iavaya.lah.com

Layer ¢ Protocal

' uop
¥ 1cp

¥ 1S

LIDF Part |5060 3:
TCP Part |5060 32
TLS Port |5061 32

Remote UDP Part |5oso 3:
Remate TCP Port |5oso 32
Remate TLS Port |5os1 32

Challenge Expiration Time {sec) IID 3:

[FRTP
—Port Number Range

Minimurm |49152 3: Maimum |53246 3:
—Port Mumber Range (NAT)

Minimurm |49152 3: Maimum |53246 3:
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Scroll down the page.

| IP Offices IP500%2 Main

&R BOOTP (3)
+]-¢i Operakor (3)

In the RTP Keepalives section, set the Scope to RTP-RTCP. Set the Periodic timeout
to 30 and the Initial keepalives parameter to Enabled. These settings will cause IP
Office to send a RTP keepalive packet starting at the time of initial connection and every
30 seconds thereafter if no other RTP traffic is present. This facilitates the flow of media
in cases where each end of the connection is waiting to see media from the other, as well
as helping to keep firewall ports open for the duration of the call.

In the DiffServ Settings section, IP Office can also be configured to mark the
Differentiated Services Code Point (DSCP) in the IP Header with specific values to
support Quality of Services policies for both signaling and media. The DSCP field is the
value used for media and the SIG DSCP is the value used for signaling. The specific
values used for the compliance test are shown in the example below and are also the
default values. For a customer installation, if the default values are not sufficient,
appropriate values will be provided by the customer.

All other parameters should be set to default or according to customer requirements.
Click OK to commit (not shown).

| System

Lanz | DS | voicemail | Telephony | Directory Services | System Events | sMTe | sMDR | veM | valP | voIP Security

TPS00YZ Main Law Settings Metwork Topology |
? System (1) - lﬁ ’ r
= IPS00YZ Main IMinirmurn 49152 Mairum |53246 3.
B9 Line (25)
[#--==» Control Unit {4} IV Enable RTCP Manitoring on Part 5005
[+ 4 Extension (48) 5 5 5 =
[]___a User (50) RTCP collector IP address for phones . . .
B3 Group (1) —Keepalives
[+ @3 Short Code (53) -
_____ @ Service (0) Scope IRTP-RTCP Vl Periodic timeout ISD
Bl-adfy RAS (1) Initial keepalives IEnabIed Vl
[]---@ Incoming Call Route {3)
----- 2 wan Part (0)
----- g Direckory {0}
£ Time Profile (0) —DiffSery Settings
[-{#} Firewall Profile (1) - - ) - -
[J---% 1P Route (7) IBS 3 DSCP{Hex) |B8 = Videa DSCP(Hexd) |FC = DSCPMaskiHexd |58 = SImDSCP (Hex)
----- & Account Code (0) = = . = =
|46 3. DsCP |46 3. Video DSCP 63 | DSCP Mask 34 = SIGDSCP
----- R License (90) idsa I 3 as| I 3
----- i Tunnel (0) )
I:I---ﬁ 3 User Rights (3) TR SR e
- ARS (2} Frimary Site Specific Option Number (46005600 176
----- & Location (0) -
..... m Autharization Code (0) Secondary Site Specific Option Mumber (1600f9600)  |242 =
WLAR INot Present Yl
1100 Yoice ¥LAN Site Specific Option Mumber (SSOM) |232 3:
110 Yaice YLAN IDs |
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5.2.2. System - Telephony Tab
Navigate to the Telephony - Telephony tab in the Details Pane, configure the following

parameters:

e Choose the Companding Law typical for the enterprise location, U-Law was used.

e Uncheck the Inhibit Off-Switch Forward/Transfer box to allow call forwarding and
call transfers to the PSTN via the SIP trunk to the service provider.

e All other parameters should be set according to customer requirements.

e Click OK to commit (not shown).

IP Offices

=K BOOTR (9)
COperator (3)

| IPS00YZE Main
%9 System (1}

ol

IPSO0YZ Main

£ 4 Line (25)
H--<=r Contral Unit {4)
H--4p Extension (48)
]ﬁ User {50}

]u Group (13
+--@% Short Code (69)
----- B service (0)
-l RAS (1)

Frn e W B n B W o]

w

..... @ WA Port (03
----- 4w Directory (0)
{1 Time Profile {0)
(-8 Firewall Prafile (1)
-l IP Route (7)

#m Account Code (0)
----- e, License (90)
----- i Tunnel (0)
[-fig User Rights (8)
- ARS(2)
----- i Location {0)

]@ Incoming Call Route (3)

----- m Authorization Code (0)

IPS00Y2 Main

System | Lt | Lang | oS | voicemail  Telephony |Directury Services | SystemEvents | sMTP [ svoR | vcm | volp | volP Security | Contact Center |

Park & Page | Tones & Music | Ring Tones | 5 | Call Log | TUL |

Analogue Extensions

Default Outside Call Sequence

Default Inside Call Sequence

Default Ring Back Sequence

INormaI 'l
IRing Type 1 'l
IRing Type 2 'l

Restrict Analogue Extension Ringer Voltage r

Companding Law

Swikch Line
& ULaw % -Law Line
 aLaw " A-Law Line

Dial Delay Time {sec)

Dial Delay Count

Default Mo Answer Time {sec)
Hold Timeout {sec)

Park Timeout {sec)

Ring Delay {sec)

1

ululd

300

o

Call Priority Promation Time {sec) IDisabIed 3:

Default Currency

uso =~
| —

I D55 status
¥ auka Hald
¥ | Dial By [Mame

¥ Show Account Code

™ Inhibit OFf-Switch Forward) Transfer

I Restrict Network Interconniect
™| Tnclidelocation: specific infarmation
r Drop External Only Impromptu Conference

N Wisually Differentiate External Call
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5.2.3. System —VoIP Tab

For Codecs settings, navigate to the System (1) = IP500V2 Main—>VolIP tab in the Navigation
pane, select the Codecs tab and configure the following parameters:
¢ Inthe Codecs tab of the Details pane, select or enter 101 for RFC2833 Default Payload.
This setting was recommended by Claro for use with out-band DTMF tone transmissions.
e For codec selection, select the codecs and codec order of preference on the right, under
the Selected column. The Default Codec Selection area enables the codec preference
order to be configured on a system-wide basis. The buttons between the two lists can be
used to move codecs between the Unused and Selected lists, and to change the order of
the codecs in the Selected codecs list. By default, all IP phones (SIP and H.323) will use
the system default codec selection shown here, unless configured otherwise for a specific
extension. The example below shows the codecs used for IP phones (SIP and H.323), the
system’s default codecs and order was used.

| IP Offices 5 IP500V2 Main

=R BOCTP (3] ‘system | LANL | LAz | DNS | voicemail | Telephony | Directory Services | System Events | smte | smpR | wem
Bl Cperator (3)
2| IPS00Y2 Main Ignore DTMF Mismatch For Phones -
B System (1) &llaw Direct Media Within MAT Location |
L-tag IPSO0YZ Main
B Line (25) |RFC2833 Default Payload fion | =
[+ Control Unit {4}
[ Extension (43) — fAwailable Codecs —Default Codec Selection
E-§ User (50) —Unused ———— - Selected
-8 Group (1) G711 LLAW 64 G.722 6K == | | [a7itucw ee
-8 Short Code (69) B.71L ALY B4 G.711 ALAW Gk
----- B service (0 Gl?22 ek | 5.729(a) 8K CS-ACELP
[]...“g; RAS (1) ' .723.1 6K3 MP-MLGQ
[]---e Incoming Call Route (3) G.729(a) B C5-ACELP = |
..... @ WAN Part (0} G.723.1 6K3 MP-MLG
----- a4 Directory (0) _I
f:.“ Time: Profile (0}
[]---@ Firewall Profile {1) il
-l 1P Route (7)

Note: The codec selections defined under this section (System — Codecs Tab) are the codecs
selected for the IP phones/extensions. The codec selections defined under Section 5.4.4 (SIP
Line — VolIP tab) are the codecs selected for the SIP Line (Trunk).
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5.3. IP Route

Create an IP route to specify the IP address of the gateway or router where IP Office needs to
send the packets in order to route calls to Claro’s network (if located in a different IP subnet).

In the reference configuration, the IP Office LANL1 interface and the interface of the VPN
gateway resided in different IP subnets, so an IP route was necessary to specify the IP address of
the gateway or router where IP Office needs to send the packets, in order to reach the IP subnet

where the VPN gateway resides.

To create an IP route to specify the IP address of the gateway or router where the IP Office needs
to send the packets in order to reach the IP subnet where the VPN gateway resides (if located in
different IP subnets), on the left navigation pane, right-click on IP Route and select New.
e Set IP Address to 172.31.21.0 (IP subnet assigned to Claro’s SIP Proxy).
e Setthe IP Mask to 255.255.255.0 (IP Mask assigned to Claro’s SIP Proxy).
e Set Gateway IP Address to the IP address of the router where IP Office is connected.
Gateway IP Address 10.64.70.53 was used in the sample configuration, which correspond
to the IP address assigned of the virtual router used to route calls to the VPN gateway.

Refer to Figure 1.

e Set Destination to LAN1 from the drop-down list.
e Click the OK to commit (not shown).

IP Offices

=K BOOTP (3)
g5 Operator (3)
-5 System (13
- Ly IPSOOYZ Main
F-F7 Line (25)
-2 Control Unit {4)
- Extension (4]
a User (50
a Group (1)
(-8 Shart Code (699
- @B Service (0)
,,% RAS (1)
@ Incoming Call Rouke (3)
- Eg) WAN Port (D)
s Directary (0
- £ Time Profile (0)
@ Firewwall Profile (17

=-

IF Route |

IP Address

IP Mask,

Gateway IP Address
Destination

Mekric

172.31.21.0

|1?2.31.21.n

|255 . 255 . P55 . D)

|1D.54.?D.53

[Lan1

fo

r Proxy ARP
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5.4. SIP Line

DevConnect generated SIP Line templates are always exported in an XML format. These XML
templates do not include sensitive customer specific information and are therefore suitable for
distribution. The XML format templates can be used to create SIP trunks on both IP Office
Standard Edition (500 V2) and IP Office Server Edition systems. Alternatively, binary templates
may be generated. However, binary templates include all the configuration parameters of the
Trunk, including sensitive customer specific information. Therefore, binary templates should
only be used for cloning trunks within a specific customer’s environment.

Copy a previously created template file to a location (e.g., \temp) on the same computer where IP
Office Manager is installed.

To create the SIP Trunk from the template, right-click on Line in the Navigation Pane, then
navigate to New - New from Template->Open from file.

IP Offices

- &K BOOTP (9) ;I SIP Line |Tran5|:u:|rt|CaII Details|voIr | 738 Fax| SIP Credentials|SIP 4

4% Operator (3)

E...s..?__, IPS00Y 2 *J N R 117 3:
...s-.,_:__, 5':."5':3 I
L:_| oy
B FIRT crle

..... a2 |5y Copy Chrl+C I
..... : i i; L Paste ChY ISIF‘ LRI
_____ - 10| 75 Delete Ckrl+Del ICI::nuu:I
----- ", 20| 4 walidate
: i; Connect Ta... Chrl+T
..... "y, 25 Mew From Template 2 | Cpen from file
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Navigate to the directory on the local machine where the template was copied and select the
template.

G{ :p\—/ | m. + Administrator = Downloads - - lmjl Search Downloads !/_t]
Orgamize *  Mew Folder = ~ [ u@u

Fs - r FY

r Favorites _l Marne | Dake mu:u:hﬁed_l
| AF-7O01090575-151021-161456, =ml 10/2112015 1C

Adrniniskr ator
& e i ﬂ Claro_IPC11,xml
M .oracle_jre_usage LI <

File narre: ICIaru:u_IPOll.me j ITEmpIate Files (*xml) j
Open Cancel |

Al

After the import is complete, a final import status pop-up window will open stating success or
failure. Click OK

Template Provisioning E

:l Mew SIP Trunk created successfully using selected kemplake,

The newly created SIP Line will appear in the Navigation pane (e.g., SIP Line 17).

.--It BOOTP (9]
G4 Operator (3)
=] IPSO0YZ Main

[#-==F Syskem (1)

- lve )

It is important that the SIP Line configuration be reviewed and updated if necessary after the SIP
Line is created via the template. The resulting SIP Line data can be verified against the manual
configuration shown in Sections 5.4.1 to 5.4.5.
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5.4.1. SIP Line-=SIP Line Tab

On the SIP Line tab in the Details pane, configure or verify the parameters as shown below.

e Leave the ITSP Domain Name blank. Note that if this field is left blank, IP Office
inserts the far end's ITSP Proxy Address from the Transport tab as the ITSP Domain in
the SIP messaging.

e Verify that URI Type is set to SIP URI.

e Verify that In Service box is checked, which is the default value. This makes the trunk
available to incoming and outgoing calls.

e Verify that Check OOS box is checked, the default value. IP Office will use the SIP
OPTIONS method to periodically check the SIP Line. The time between SIP OPTIONS
sent by IP Office will use the Binding Refresh Time for LAN1.

e Verify that Refresh Method is set to Auto.

e Verify that Timer (seconds) is set to On Demand.

e Under Redirect and Transfer, set Incoming Supervised REFER and Outgoing
Supervised REFER to Never (Refer to Sections 2.1 and 2.2).

e All other parameters should be set to default or according to customer requirements.

e Click OK to commit (not shown).

IP Offices E SIP Line -Line 17

& BOOTR(9) = Transportl Call Detailsl VaIP |T38 Faxl SIP Credentialsl SIP Advancedl Engineeringl
+ ¥ Operator (3)
- | Line Mumber Il? ﬁl In Service 73

[#]-#29 System (1)
=-13{Ce 251 ITSP Domain Mame | Check 005 r~

Local Domain Mame I
..... 2

----- 217 ]| |URI Type |5tP LRI |

..... "y, 19 Location ICIoud

- Session Timers

Ll L

Refresh Method IAuto

k] 1

""" g, 20 Timer (sec) IOn Demand

Prefix

..... wy, 23 I
""" 1201 Mational Prefix ID

..... 17 203 International Prefix IUU

..... FT 204
T Country Code I

-Redirect and Transfer

""" 1 206 Mame Priarity ISystem Default j i) S R INever

Lel Lo

- - Cukgoing Supervised REFER Mewver
----- 17 208 Description |Serwce Provider gaing ~up I

..... 7 209 Send 302 Moved Temparariy [
----- T4 210 Qukgoing Blind REFER r
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5.4.2. SIP Line - Transport Tab
Select the Transport tab. Set or verify the parameters as shown below.
e Set ITSP Proxy Address to 172.31.21.1, the IP address of Claro’s SIP Proxy.
e Set Layer 4 Protocol to UDP.
e Set Use Network Topology Info to None.
e Setthe Send Port and Listening Port to 5060.
e Set Use Network Topology Info to None (see note below).
e Default values may be used for all other parameters.
e Click OK to commit (not shown).

6 — . -
IP Offices = SIP Line -Line 17
=R BOOTP (3) || 'stp Line[ Transport |cal Detais| votp | 738 Fax| 1P Credentials| 51P Advanced| Enginesring|
---J,_;.- Operator (3
- IPSO0YE Mair ITSP Proxy Address |1?2-31 211
[el-*=p Systern (1]
-3 |Line (253 — Metwark Configuration
..... o 1 .
_____ . Laver 4 Protacal [uor | sendport fsoeo =
""" ::- ' Use Metwark Topology Info INnne j Listen Port ISDED ﬁ
----- 16
----- ., 19 -
_____ w, 20 Explicit DNS Server(s) I o . o0 . o0 . 0 I o .0 .0 .0
""" oy, 21 Calls Route via Registrar [+
..... oy, 22
..... ., 23
----- Fqzm Sepatate Reqgistrar I

Note — For the compliance testing, the Use Network Topology Info field was set to None, since
no NAT was used in the test configuration. In addition, it was not necessary to configure the
System = LAN1 - Network Topology tab for the purposes of SIP trunking. If a NAT is used
between Avaya IP Office and the other end of the trunk, then the Use Network Topology Info
field should be set to the LAN interface (LANL1) used by the trunk and the System - LAN1 >
Network Topology tab needs to be configured with the details of the NAT device.
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5.4.3.

SIP Line — Call Details Tab

A SIP URI entry needs to be created to match each incoming number that IP Office will accept
on this line. Select the Call Details tab, and then click the Add... button and the screen shown
below will appear. To edit an existing entry, click an entry in the list at the top, and click the

Edit...

button. In the example screen below a new entry was added. For the compliance test, a

single SIP URI entry was created that matched any DID number assigned to an IP Office user.
The entry was created with the parameters shown below:

e Associate this line with an incoming line group by entering a line group number in the
Incoming Group field. This line group number will be used in defining incoming call
routes for this line. Similarly, associate the line to an outgoing line group using the
Outgoing Group field. The outgoing line group number is used in defining short codes
for routing outbound traffic to this line. For the compliance test, a new incoming and
outgoing group 17 was defined that only contains this line (line 17).

e Set Max Sessions to the number of simultaneous SIP calls that are allowed using this SIP
URI pattern.

e Set the Credentials field to 0:<None>

e Set the Local URI, Contact, P Asserted ID and Diversion Header fields to the values
shown in the screenshot below.

e Default values may be used for all other parameters.

e Click OK to commit (not shown).

e Click OK to commit again (not shown).

isll SIP Line - 17 | Call Details | SIP URI
FeworRt - —————

Incaming Group 'l Max Sessions |1D 3:

Outgaing Group |17 vl

Credentials 0: <Mone> 'l

Dizplay Content r— Field meaning
Outgoing Calls Formarding/Twinning Incoming Calls

Local LRI ILIseIntEmaIData j ILIseIntemaIData j ICaIIer j IDriginaI Caller j ICaI\ed j

Contact IUseIntemaIData j IUselntemaIData j IEaIIer j IEa\Iel j IEaHed j

P &sserted 1D = IUseIntemaIData j IUseIntemaIData j INnna j IEEHEI j INnne j

PFrefered ID T INnne ﬂ INnnE j INDna j INone j INone j

Diversion Header IUselntemaIData j IUselntemaIData j INDna j IEa\Iel j INone j

Remote Pary 100 T INone j INone j INnna j INDHE d INnne j

ag | Cancel | Help |
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5.4.4. SIP Line - VoIP Tab

Select the VoI P tab, to set the VVoice over Internet Protocol parameters of the SIP Line. Set or
verify the parameters as shown below.

e In the sample configuration, the Codec Selection was configured using the Custom
option, allowing an explicit order of codecs to be specified for the SIP Line. The buttons
allow setting the specific order of preference for the codecs to be used on the SIP Line, as
shown. Codec’s G.711ULAW, G.711ALAW and G.729(a) were selected for audio.

e Select None for Fax Transport Support (Refer to Sections 2.1 and 2.2).

e Set the DTMF Support field to RFC2833. This directs IP Office to send DTMF tones
using RTP events messages as defined in RFC2833.

e Check the Re-invite Supported box to allow for codec re-negotiation in cases where the
target of an incoming call or transfer does not support the codec originally negotiated on
the trunk.

e Check the PRACK/100rel Supported box, to advertise the support for reliable
provisional responses and Early Media to Claro.

e Default values may be used for all other parameters.

e Click OK to commit (not shown).

IP Offices E SIP Line -Line 17

: R BoOTPR () | =e Linel TransporthaII Details T36 Faxl SIF Credentialsl SIP AdvancedlEngineeringl
+]--qv¢  Operator (3)
|- [IPS00YZ Main ¥ valP Silence Suppression

% System (1) ™ Lacal Hald Music

=1L
49| Line (25) |C0dec Selection |Custom| =l —

..... 1 ¥ Re-invite Supported
..... -2 Unused ——————— — Selecked
..... . [17] G2 edk = G711 ULAW BaK ™ codec Lockdown

..... W, 18 G.723,1 6K3 MP-MLG G.711 ALAW B4K I~ allow Direct Media Path
G.729(a) 8K, C5-ACELP

I™ Faorce direct media with phomes

o ¥ PRACK/100rel Supported

[T G.711 Fax ECan

s

AHENENR]

----- 9 205 Fax Transport Suppork INone

Lel Lo

..... 7 207 DTMF Support IRFC2833

_____ 17 209 Media Security IDisabIed j

Note: The codec selections defined under this section (SIP Line — VoIP tab) are the codecs
selected for the SIP Line (Trunk). The codec selections defined under Section 5.2.3 (System —
V/oIP tab) are the codecs selected for the IP phones/extension (H.323 and SIP).
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5.4.5. SIP Line — SIP Advanced Tab

Select the SIP Advanced tab. For outbound calls with privacy enabled, Avaya IP Office will
replace the calling party number in the From and Contact headers of the SIP INVITE message
with “anonymous”. IP Office can be configured to use the P-Preferred-ldentity (PPI) or P-
Asserted-Identity (PAI) header to pass the actual calling party information for authentication and
billing purposes. By default, IP Office will use the PPI header for privacy. To configure IP
Office to use the PAI header for privacy calls:

o Verify that Call Routing Method is set to Request URI.

e Check the box for Use PAI for Privacy.
e Default values may be used for all other parameters.
e Click OK to commit (not shown).
IP Offices E SIP Line - Line 17
E- & BOOTR () 1P Llnel Transportl Call Detallsl volP |T38 Faxl SIP Credentials nglneerlngl
Operatar (3)
—Addressing ~Media
Association Method IBy Source IP address j Allow Empty INVITE r
S8 T’ - Send Empty re-IMVITE |
----- |Ca|| Routing Method IRequest LRI | j
..... .'_ 2 Allaw Ta Tag Change r
..... y, Suppress DNS SRY Lookups | P-Eatly-Media Suppart INone 'l
:: ig —Iddentity Send SilenceSupp=0FF r
_____ "y, 20 Use "phane-context” - Force Eatly Direct Media T
..... wy, 21 T T - Media Connection IDisabIed vl
..... wy, 22 . Preservation
_____ ~, 23 Use + for International N Indicate HOLD -
7 201 Lse PAT For Privacy v I
----- 7 202 Use Domain for PAT I =@t
i —Call Control
""" T_’. 203 Caller ID from From header I
}4{; ;g; P r Call Initiation Timeout {s) |4 3:
..... 71 206 Cache Auth Credentials v Call Quewing Timeout (mins) |5 3:
----- 9 207 User-Agent and Server I )
_____ 7 208 Headers Service Busy Response |486 - Busy Here j
""" }:ﬁ 2?3 Send Location Infa INever 'l gznl\élo User Responding |4087Request Timeouk j
..... 7 211 #Add LT header I Action on CAC Location " pr =
..... 7 212 Add UUI header to redirected o Limnit IA"DW Veicemai J
..... 1213 calls Suppress (.850 Reason -
..... 1 214 Header
..... F1 215 Emulate NOTIFY for REFER. [~
""" 1 216 Mo REFER if using Diversion |
[ Control Unit {:
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5.5. Users

Configure the SIP parameters for each user that will be placing and receiving calls via the SIP
Line defined in Section 5.4. To configure these settings, first navigate to User > Name in the
Navigation pane where Name is the name of the user to be modified. In the example below, the
name of the user is H323 ext 1502. Select the SIP tab in the Details pane. The values entered for
the SIP Name allow matching of the SIP URI for incoming calls without having to enter this
number as an explicit SIP URI for the SIP Line (see Section 5.4.3). The SIP Name and Contact
are set to one of the DID numbers assigned to the enterprise by Claro. The SIP Display Name
(Alias) parameter can optionally be configured with a descriptive name. If all calls involving this
user and a SIP Line should be considered private, then the Anonymous box may be checked to
withhold the user’s information from the network. This can also be accomplished by activating
Withhold Number on H.323 Deskphones (not shown). Click the OK to commit (not shown).

IP Offices H323 ext 1502: 1502"
..... 1596 Extnl596 d I " ) ) ) ) . - .
Telephony | Forwarding | Dial In | Vaice Recording | Butkon Prograrmming | Menu Programming | Mabiliey | Group Membership | dnnouncements | SIP
----- 1597 Extn1597 | | | | | |
----- 1593 Extn1593 SIP Marmne |1234569226
----- 1599 Extn1599
..... 1600 Extnl&00 SIP Display Mame (Alias) |H323 ext 1502
""" 1601 Extni601 Cantact 1234569226
----- 1602 Extnl602
----- 1603 Extnl603
----- i [1502 H323 ext 1502 W ErammEs
----- 1542 H323 ext 1542
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5.6. Outbound Call Routing

For outbound call routing, a combination of system short codes and Automatic Route Selection
(ARS) entries are used. With ARS, features like time-based routing criteria and alternate routing
can be specified so that a call can re-route automatically if the primary route or outgoing line
group is not available. While detailed coverage of ARS is beyond the scope of these Application
Notes, and alternate routing was not used in the reference configuration, this section includes
some basic screen illustrations of the ARS settings used during the compliance testing.

5.6.1. Short Codes and Automatic Route Selection

To create a short code to be used for ARS, right-click on Short Code on the Navigation pane
and select New. The screen below shows the short code 9N created (note that the semi-colon is
not used here). In this case, when the IP Office user dials 9 plus any number N, instead of being
directed to a specific Line Group ID, the call is directed to Line Group 50: Main, which is
configurable via ARS.
e Inthe Code field, enter the dial string which will trigger this short code. In this case, 9N
was used (note that the semi-colon is not used here).
e Set Feature to Dial. This is the action that the short code will perform.
e Set Telephone Number to N. The value N represents the number dialed by the user after
removing the 9 prefix. This value is passed to ARS.
e Setthe Line Group ID to 50: Main to be directed to Line Group 50: Main, which is
configurable via ARS.
e Setthe Locale as required, United States (US English) was used for the testing.
e Click the OK to commit (not shown).

IP Offices = 9N: Dial
;I Short Code |
Code fond
Feature IDiaI
Telephone Mumber IN
Line Group ID ISIZI: Main
Locale ILlniteu:I States (U5 English)
Force Account Code r
Force Authorization Code [
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The following screen shows a sample ARS configuration for the route Main. Note the sequence
of X’s used in the Code column of the entries to specify the exact number of digits to be
expected, following the access code and the first set of digits on the string. This type of setting
results in a much quicker response in the delivery of the call by IP Office.

To create a short code to be used for ARS, select ARS - 50: Main on the Navigation pane and
click Add.
e Inthe Code field, enter the dial string which will trigger this short code. In this case, 1
followed by 10 X’s to represent the exact number of digits.
e Set Feature to Dial. This is the action that the short code will perform.
e Set Telephone Number to 1N. The value N represents the additional number of digits
dialed by the user after dialing 1 (The 9 will be stripped off).
e Setthe Line Group ID to the Line Group number being used for the SIP Line, in this
case Line Group ID 17 was used.
e Set Locale as required, United States (US English) was used for the testing.
e Click OK to commit.

Edit Short Code

Code J 104000004
Feature IDiaI j

Telephone Mumber I'I M

Line Group D [17 =]

Lacale Urited States [US Engish) > ]

Force Account Code r
Farce Authorization Cade [

Repeat the above procedure for additional dial patterns to be used by the enterprise to dial out
from IP Office.
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The example highlighted below shows that for calls in the North American numbering plan, the
user dialed 9, followed by 1 and 10 digits (represented by 10 X’s). The 9 is stripped off, the
remaining digits, including the 1, are included in the SIP INVITE message IP Office sends to

Claro.

IP Offices

=R BOOTR (3)
Operator (3}
[ezmar]
[H-#3p System (1)
B-F9 Line (25)
[#-+= Conkrol Unit {4}
[H-4f Extension (43)
£
£
£

]a User (50}
]u Group (1)
/-@% Short Code (69)
----- B Service (D)
oy RAS (1)

..... £8 wan Part (0)

----- g Directory {0}
£ Time Profile (0}
-4} Fireweall Profile (1)
G- Jill TP Raute (7)

----- & Account Code (0)
----- W License (90)

----- i Tunnel (0)

E-fig User Rights (8)

2 ¢ fers 2)
¥ 50: Main

..... Ha Location (0)

[]---@ Incoming Call Route (3)

51 Qutbound Fax

----- 28 suthorization Code (0)

ﬁ Main™

ARS |

ARS Route ID

o

Route Mame IMain

v Secondary Dial kone ————
ISystemTone

Al add

Remove

Edit...

bk,

Dial Delay Time ISystem Default (4) 3: ¥ Check User Call Barring
Descripkion ||
In Service v Qut of Service Route
1
Tirne: Profile <Mone = ¥ | et Ot 0F Hours Route
Code | Telephone Murnber | Feature | Line Group ID
165 16M Dial 17
| LR 1N Dial 17|
ZERRERRN ZM Dial 17
411 411 Dial 17
611 611 Dial 17
ettt &M Dial 17
A1YEYEYYYY a1M izl el e
[ D

Alternate Route Priority Lewvel |3 'l

Alternate Route Waik Time ISD 3: ety 3|EETIEEE ROULE
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5.7. Incoming Call Route

An incoming call route maps inbound DID numbers on a specific line to internal extensions, hunt
groups, short codes, etc., within the IP Office system. In a scenario like the one used for the
compliance test, only one incoming route is needed, which allows any incoming number arriving
on the SIP trunk to reach any predefined extension in IP Office. The routing decision for the call
is based on the parameters previously configured for Call Routing Method and SIP URI
(Section 5.4.3) and the users SIP Name and Contact, already populated with the assigned Claro
DID numbers (Section 5.5).

5.7.1. Incoming Call Route — Standard Tab

To create an incoming call route, right-click Incoming Call Routes in the Navigation pane and
select New.

On the Standard tab of the Details pane, enter the parameters as shown below.
e Set the Bearer Capacity to Any Voice.
e Setthe Line Group Id to the incoming line group of the SIP line defined in Section 5.4.
e Default values can be used for all other fields.

IP Offices B 17
“‘ BOOTF (9) Standard | yoice Recording | Destinations |
% Operator (3)
=] IPS00Y2 Main
[+-529 System (1) Beater Capability I.ﬁ.ny Yoice j
T Line (25) _
= Contral Unit (4) Line Group ID Il? j
¢ Extension (45) Incoming Murmber I
ﬁ ser (500
a aroup (1) Incoming Sub Address I
- B Short Code (69) _
..... @ Service (0] Incoming CLI I
hg‘ RAS (1) Locale I j
EI@ Incoming Call Rouke {3}'
e 0 Pricrity |1 - Low j
L ]
Tag I
----- £l WaN Port (0
_____ EE Directu:u:-' {I:D}:I Hold Music Source ISystem Source j
""" £ Time Profile (0) Ring Tane Cverride IN:::ne j
+-{@8) Firewall Profile (1)
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5.7.2. Incoming Call Route — Destinations Tab

e Under the Destinations tab, enter “.” for the Default Value. This setting will allow the
call to be routed to any destination with a value on its SIP Name field, entered on the
SIP tab of that User, which matches the number present on the user part of the incoming

Request URI.

e Click OK to commit (not shown)

IP Offices

=- R BOOTP (9)

gw Operator (3)

---L-:_s Syskem (1)
£-F7 Line (25)
<2y Conkral Unit (4)
-y Extension [43)
: a =zer (507
a Group (1)

-8 short Code (63)

- -

[+l RAS (1)

5...@%uming Call Route (3]

WA Port ()

] 17
.Standard | Yoice Recording | Destinations
TimePrafile Destination Fallback Extension
» Defaulk Yalue j
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5.8. Save Configuration

Navigate to File = Save Configuration in the menu bar at the top of the screen to save the
configuration performed in the preceding sections.

The following will appear, with either Merge or Immediate selected, based on the nature of the
configuration changes made since the last save. Note that clicking OK may cause a service
disruption. Click OK to proceed.

Save Configuration [_ ]
—IP Office Settings

IPS00ME Main

—i_onfiguration Rebook Mode
¥ Merge

" Immediate

" wWhen Free

" Timed

—Reboaok Time

o0z =1

—iZall Barring

r Incoming Calls
] Cutgoing Calls

Ok, I Zancel Help
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6. Claro SIP Trunking Service Configuration

To use Claro’s SIP Trunking Services, a customer must request the service from Claro using the
established sales processes. The process can be started by contacting Claro via the corporate web
site at: http://www.claro.com.do/wps/portal/do/sc/empresas and requesting information.

During the signup process, Claro and the customer will discuss details about the preferred
method to be used to connect the customer’s enterprise network to Claro’s network. Claro will
provide IP addresses, Direct Inward Dialed (DID) numbers to be assigned to the enterprise, etc.
This information is used to complete the Avaya IP Office configuration discussed in the previous
sections.

Claro is responsible for the configuration of Claro SIP Trunking Service. The customer will need
to provide the public IP address used to reach IP Office at the enterprise.

During the interoperability testing, a VPN connection was used to connect the simulated
enterprise site to Claro’s network via the public Internet. The connection could also be done
without the use of a VPN connection.
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7. Verification Steps

This section provides verification steps that may be performed to verify that the solution is
configured properly.

The following steps may be used to verify the configuration:
o Verify that endpoints at the enterprise site can place calls to the PSTN.
e Verify that endpoints at the enterprise site can receive calls from the PSTN.
e Verify that users at the PSTN can end active calls to endpoints at the enterprise by
hanging up.
o Verify that endpoints at the enterprise can end active calls to PSTN users by hanging up.

7.1. Avaya IP Office System Status
The following steps can also be used to verify the configuration.

Use the Avaya IP Office System Status application to verify the state of SIP connections.
Launch the application from Start - Programs -> IP Office - System Status on the PC
where Avaya IP Office System Status is installed, log in with the proper credentials.

AVAyA IP Office System Status

Help Exit About

Online  offine

Logon

Control Unit IP Address: BIE:T R R4

Services Base TCP Port: ELELE]

=D T [ Administrator

M Auto reconnect

[l Secure connection Logon
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Select the SIP Line under Trunks from the left pane. On the Status tab in the right pane, verify
the Current State is Idle for each channel.

IP Office System Status

SIP Trunk Summary
Line Service State: In Service
Peer Domain Name: sipyff172.31.21.1
Resolved Address: 172.31.21.1
Line Mumber: 17
Number of Administered Channels: 10
MNumber of Channels in Use: 0
Administered Compression: G711 Mu, GT11 A, GF29 A
Enable Faststart: Off
Silence Suppression: Off
Media Stream: RTP
Layer 4 Protocol: UDP
SIP Trunk Channel Licenses: 128 . -~
SIP Trunk Channel Licenses in Use: 0
SIP Device Features: UFDATE (Incoming and Outgoing)
.. Time in Remote C... Con... Caller Other Dire... Round Rec... Rec... Tran...
State  Media... ID o... Partyon... Trip ...
1 Ide [04:5...
2 Ide |04:5...
3 Ide |4da...
4 Ide |4da...
5 Ide [4da...
6 Ide [4da...
7 Ide |4da...
a8 Ide |4da...
q Ide |4da...
10 Ide [4da...
Trace [ Trace All ] [ Pause ] [ PFing ] Call Details Graceful Shutdown ] [ Force Qut of Service

Print... ” Save As... ]
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Select the Alarms tab and verify that no alarms are active on the SIP Line.

IP Office System Status

Status  Utilization Summary Alarms

Alarms for Line: 17 SIP sip://172.31.21.1

Last Date Of Error Ocaurrences Error Description

»
Line: 18
Line: 19

Line: 20
Line: 21

Clear Clear all Graceful Shutdown l [ Force Out of Service Print... Save As...
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7.2. Avaya IP Office Sys Monitor

The Avaya IP Office Sys Monitor application can be used to monitor and troubleshoot
signaling messaging on the SIP trunk. Launch the application from Start - Programs - IP
Office > Monitor on the PC where Avaya IP Office Sys Monitor was installed. Click the Select
Unit icon on the taskbar and select the IP address of the IP Office system under verification.

File Edit Wiew Fikers Status Help

Iﬂ_ Avaya IP Office Sys™Monitor - [STOPPED]

S8 »lE[T| X[)

G| e

' ¢

K

Start/Stop Trace Select
Trace Options  Unit
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Clicking the Trace Options icon on the taskbar, selecting the SIP tab allows modifying the

threshold used for capturing events, types of packets to be captured, filters, etc. Additionally, the
color used to represent the packets in the trace can be customized by right clicking on the type of
packet and selecting the desired color.

All Settings — [
T1 | WPN | Wb | SCN | Jade |
&TM | cal | DTE | ECont | FrameRelay | GOD | H323 | Intedace |
SO ] Fey/Lamp l Directaom ] Media ] FFF l Rz l Routing l Semvices Systeml
Ewvents
¥ Sip Voo = [~ STUN [~ SIP Dect
|
|I "
| |
Fackets
|
| [~ SIF Rea/Opt Ax [~ SIP KMisc Rx
| [~ SIP Reg/Opt Tx [ SIP Misc Tx
||
[~ SIPCallRx [~ Cn Motify Rx
| [~ SIPCall T [ Cr Matify Tx
v Sip Bx I Filker [inmn.nnn. nine. nine)
M Sip Tx |
|
Default All | Clear All | Tab Clear Al | Tab Set &l | Cancel
SaveFle | LoadFie | LoadParialFie| SelectFie |

E— o~
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8. Conclusion

These Application Notes describe the configuration steps necessary for configuring Session
Initiation Protocol (SIP) Trunk Service for an enterprise solution consisting of Avaya IP Office
Release 11.0 to interoperate with Claro SIP Trunking Service. Claro SIP Trunking Service is a
SIP-based Voice over IP solution for customers ranging from small businesses to large
enterprises. It provides a flexible, cost-saving alternative to traditional hardwired telephony
trunks.

Claro SIP Trunking Service passed compliance testing with the observations/limitations outlined
in the scope of testing in Section 2.1 as well as under test results in Section 2.2.
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